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Preface

Oracle Order Capture Concepts and Procedures provides information and instructions 
to help you use Oracle Order Capture 11i effectively.

Intended Audience
This manual is intended for the following users:

� Sales representatives accessing Order Capture from Oracle TeleSales

� Support representatives accessing Order Capture from Oracle Customer Care

� Sales representatives from Oracle iStore

Related Documents
For more information consult the following documentation, available at 
http://metalink.oracle.com:

Oracle Order Capture Implementation Guide, Release 11i

Oracle Applications Flexfield Guide

Oracle Applications User’s Guide

Oracle Applications System Administrator’s Guide

Oracle iPayment Concepts and Procedures

Oracle Receivables Users Guide Release 11i
                                                 ix



Accessibility
Oracle’s goal is to make our products, services, and supporting documentation 
accessible to the disabled community with good usability. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program web site at http://www.oracle.com/accessibility/. 

Typographic Conventions
The following typographic conventions are used in this manual:

Convention Meaning

italic text Book titles

Courier text User commands and file content examples

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and form options

Emphasized words or phrases

< > Angle brackets enclose user-supplied names.

Note: Do not type the angle brackets.
x                                                               
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Understanding Oracle Order Capture

1.1 Overview of Understanding Oracle Order Capture
Oracle Order Capture serves as the integration point between a selection of Oracle’s 
CRM applications and Oracle’s Order Management system. You can use Order 
Capture to create quotes based on information from Oracle TeleSales 11i, Oracle 
Customer Care 11i, and iStore 11i. Once a customer accepts a quote, you can use 
Order Capture to translate the quote into an order. 

This topic group provides overviews of the application and its components, and 
explanations of key concepts, features, functions, and the application's relationships 
to other Oracle or third-party applications.

� Relationship of Order Capture to Other Oracle Applications

� Understanding the Order Capture Form

� Customers Types

� Understanding Quotes

� Understanding Quote Status

� Understanding Orders

� Item Types

� Related Items: Cross-Sell, Upsell, and Substitute

� How Items are Priced and Discounted

� Understanding the List of Values (LOV) Fields

� Understanding the Item and Price List LOVs
pture 1-1
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1.2 Relationship of Order Capture to Other Oracle Applications
Order Capture integrates with a number of Oracle’s CRM applications. These 
applications use Order Capture to create quotes and orders. While some of them 
adopt the Order Capture user interface (UI), others simply use API and database 
information. 

One aspect the following examples have in common is the use of the Trading 
Community Architecture (TCA) Model 11i. The TCA model stores customer 
information such as name, address, contacts, past billing information, past shipping 
information, and past payment information. The TCA model allows applications to 
access consistent information on all business entities. The data is available across all 
channels - phone, web, or in person - and as a result the customer information 
available to representatives across applications is accurate and consistent.

There are three main Oracle applications that Order Capture integrates with:

� Oracle TeleSales

� Oracle Customer Care

� Oracle iStore

Following are business scenarios illustrating how these three applications use Order 
Capture to create quotes and orders.

1.2.1 Order Capture and Oracle TeleSales
Oracle TeleSales is a call center-enabled application designed for internal sales 
representatives, distributors, resellers, and sales executives. With TeleSales they can 
track, manage, and execute sales in the customer sales cycle. Oracle TeleSales 
exploits Order Capture quoting and order submission functionality as part of this 
process. For example, if a customer contacts a sales organization by telephone, the 
Sales Representative can access the TeleSales application to generate the lead, 
qualify the prospects, access existing customer information and submit a quote.

To process information during each of the sales cycle phases, the Sales 
Representative accesses TeleSales’ eBusiness Center. The Sales Representative can 
click the Leads tab when processing information on a lead. He/she can also click 
the Opportunity tab when processing information on an opportunity. 

When a Sales Representative is working with a customer who is interested in 
adding items to a quote, he clicks the Quote/Order tab. The Quote/Order page is 
displayed in the lower region of the screen. Here, he/she can view all the quotes for 
the customer by clicking Quotes from the View, pull-down menu. A list of quotes 
1-2 Oracle Order Capture Concepts and Procedures                      



Relationship of Order Capture to Other Oracle Applications
for the customer displays. To view details of a selected quote, select the quote and 
click the Detail button. The Order Capture form for that selected quote is displayed.

To view a customer’s orders, select Order from the View, pull-down menu. A list of 
the customer’s orders displays. To view a particular order, select an order and click 
the Detail button. You will access the Order Management form for that order. 

On the other hand, if the Sales Representatives finds out that creating a new quote is 
required, he/she can click the New button. 

Once the Detail or New button is clicked, the Order Capture form displays. The 
TeleSales end user can then continue to use the Order Capture form to:

� Initiate new quotes

� Modify an existing quote that has not been submitted as an order

� Configure and select products in the quote

� Check on availability

� Provide price adjustment information

� Provide promotional information

� Document billing, shipping, and payment information

� Submit the order and provide an order number

1.2.2 Order Capture and Customer Care
Oracle Customer Care is used to track customer interactions and services after a 
quote is submitted. When a customer call requires help with a product they 
ordered, the customer sometimes discovers they need to order an additional item. 
The Customer Care representative can access the Order Capture form from 
Customer Care’s Quick Menu and prepare a quote.

For example, Jim Johnson from Business World bought some Envoy Laptop 
computers. He now needs some cables. Mary Lee, a Customer Care representative, 
receives a call from Jim at Business World requesting five cables. 

Mary accesses the main Customer Care interface — the Contact Center. From the 
toolbar she chooses Tools > Quick Menu. Mary then clicks Order Capture. The 
Order Capture form displays. Mary starts a new quote for Business World that 
includes the five cables.
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1.2.3 Order Capture and iStore
Customers can place orders over the Internet as well as through a TeleSales or  
Customer Care Representative. When a customer visits a website created by Oracle 
iStore, Order Capture APIs are used to save shopping carts and to submit orders. 

Order Capture APIs are used to view and modify shopping carts from iStore. Order 
Capture APIs are also used to submit orders to Order Management. iStore and 
Order Capture applications get customer information from the TCA schema.

For example, Jim Johnson from Business World visits Vision Corporation’s website. 
Jim places 10 mouse pads in the shopping cart. The phone rings and Jim leaves his 
cart on-line. Later Jim returns to the Vision Corporation website and adds five 
standard desktop computers to his cart. Jim’s boss enters the office with a customer 
problem Jim has to solve. Jim leaves the website again.

Jim leaves for an out of town business trip. He does not have access to a computer. 
He needs to add three printers to his cart, so Jim calls Vision Corporation.

Jim reaches a TeleSales Representative. Jim provides the shopping cart name. The 
TeleSales Representative accesses the shopping cart name through Quote/Order tab 
in the e-Business Center. Since Jim and Business World have done business with 
Vision Corporation before, the customer information is available. The TeleSales 
Representative updates his cart/quote.

Summary
� Products can be placed in the shopping cart in iStore, saved, and the cart can be 

accessed again, using Order Capture. 

� The shopping cart can be retrieved and modified in Order Capture using the 
customer name and the shopping cart name.

� Any changes made in Order Capture can then be viewed by the customer in 
iStore. The customer can subsequently place the order in iStore.

� Due to the integration between Order Capture, TeleSales, and Customer Care 
applications, the iStore shopping cart can be viewed and modified by the end 
users of TeleSales and Customer Care. 

1.3 Understanding the Order Capture Form
The Order Capture form is divided into the following regions:

� Header Information Region
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� Item View

� Shopping Cart View Tab

� The Bill To Tab

� The Ship To Tab

� The Payment Tab

� The Quote Total Region

� Save Quote and Book Order Buttons

See also:

� Understanding the Order Capture Form

� Understanding Quotes

� Understanding Quote Status

� Understanding Orders

� Item Types

� How Items are Priced and Discounted

� Related Items: Cross-Sell, Upsell, and Substitute 

1.3.1 Header Information Region
The Header Information Region header information region displays:

� Basic information about the customer who is placing the order. This information 
comes primarily from calling applications. Oracle TeleSales provides customer 
information based on an opportunity. Customer Care provides customer 
information based on a customer interaction. Oracle iStore provides customer 
information based on the details a customer enters when registering with iStore.

� Quote information, such as the quote number, version, and status. A quote is 
created when you add items to the shopping cart and save your selections. 

1.3.2 Item View 
Use this tab to perform the following tasks:

� Select basic information and view prices of items your customer may be 
interested in purchasing. See Using Oracle Order Capture for details.
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� View the availability of an item by checking the Available Qty field. (This 
functionality is available only if your administrator has enabled it in Order 
Capture.)

� View and modify the quantity of an item.

� View the price of an item and modify it by changing your price list selection. 
See Using Oracle Order Capture for details.

� Add items to the shopping cart.

The first line of the Item View tab contains the Current Item field, the Items in 
Shopping Cart field, and buttons that you can use to display the next, previous, 
first, or last items in the shopping cart. This line shows the following information:

� If the item displayed in the Item View tab has been added to the shopping cart

� How many items are in the shopping cart or quote

The Current Item field indicates the position of an item in the cart or quote. If the 
Current Item field is blank, then the item has not been added to the cart.

The Items in Shopping Cart field shows the total number of items in the quote or 
cart. A blank Items in Shopping Cart field means the shopping cart is empty.

If the Current Item field is blank and:

1. If the Item View tab displays an item, the item has not been added to the 
shopping cart or quote. Click Add to Cart to add this item to the cart, or click 
Clear to clear the item from the Item View tab.

2. If the Item View tab does not display an item, you can enter a new item.

If both the Current Item field and the Items in Shopping Cart field have numbers, 
you are viewing an item that has been added to the shopping cart and is a line item 
in the quote. You can modify this item or click Remove to remove it from the cart or 
quote. You can also use the arrow buttons on the panel to navigate to other items in 
the cart. 

Use the following arrow buttons to scroll through the items in a quote and to create 
a new item in the quote:

� Use the right arrow button to advance to the next item in the quote. If you are 
viewing the last item in the quote, clicking this button creates a new item in the 
cart.

� Use the left arrow button to go to the previous item in the cart.

� Use the double right arrow button to go to the last item in the quote.
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� Use the double left arrow button to go to the first item in the quote.

You can also view information about any substitute, upsell, or cross-sell items 
linked to the item by clicking the Related Items button. This button is disabled if 
there are no related items.

You can view included warranty information for the item displayed by clicking the 
View Warranty button, which is enabled only if the item is serviceable. Included 
warranties are included in the purchase price of the item and will not show up as 
separate line items in the quote. Service items, such as extended warranties, can also 
be purchased separately.

To select an item in inventory that is not yet in the cart, first ready the cart using one 
of the following methods:

� Click on the button with the green plus sign (New) in the toolbar.

� Select File > New.

� Click the next item button in the Item View tab while viewing the last item in 
the quote.

� Use the down arrow key to scroll to the last item in the quote.

1.3.3 Shopping Cart View Tab
The Shopping Cart View tab lists the contents of your shopping cart or the quote 
you have created. You cannot make any changes here. You must go to the Item View 
tab to view item details and modify the contents of the shopping cart.

1.3.4 The Bill To Tab
The Bill To tab displays the billing address and contact for the order as a whole.

You must enter a billing address before you can save the quote or place the order.

Check the Ship to Same Address box if the items should be shipped to the billing 
address.

Address Detail form
Click the oval button next to the address fields in the Bill to Address and Ship to 
Address tabs to view the Address Detail form. Clicking the oval button in the Bill to 
Address tab opens the Address Detail (Invoice To) form, while clicking the oval 
button in the Ship to Address tab opens the Address Detail (Ship To) form. Use this 
form to display billing and shipping address details.
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1.3.5 The Ship To Tab
The Ship To tab displays the shipping contact and address for the order as a whole.

If you do not enter any values here, Oracle Order Management will use the billing 
address as the shipping address when it receives the order from Oracle Order 
Capture.

1.3.6 The Payment Tab
The Payment tab allows you to enter payment information for the order. 

If you do not enter information into a Payment view field, Oracle Order 
Management will enter default payment information, based on the OM defaulting 
rules, once it receives the order from Oracle Order Capture.

If you enter information into a Payment view field, you must also enter all required 
payment information before you can submit the order. Required fields are yellow, 
optional fields are white, and fields where you should not enter information are 
gray, except for the drop-down lists.

To enter payment information specific to a payment type, you must first select a 
value from the Payment Type field.

Customers can pay for an order by:

� Cash

� Check

� Credit card

� Purchase order

If the customer is paying by credit card, Oracle iPayment will fill in the Approval 
Code field once the order is submitted.

1.3.7 The Quote Total Region
The Quote Total region shows the total quote price. This includes discounts, taxes, 
and shipping. Note that the tax and shipping amounts are estimates only. To obtain 
exact shipment and tax amounts for an order, you must use Oracle Order 
Management after you place the order.

All fields are read-only. You cannot make any adjustments here.
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1.3.8 Save Quote and Book Order Buttons
You can create a quote when a customer is not ready to make a purchase or to 
present a customer with different pricing scenarios. The Save Quote button saves 
all the latest changes that were made since the last time the quote was saved.

Book Order places the order and sends the information to Oracle Order 
Management for processing. Use this button if your customer is ready to make a 
purchase. If the submission is successful, you receive a confirmation number which 
corresponds to the order number in Oracle Order Management. If the submission is 
not successful, an error message appears.

1.4 Customers Types
You can sell to two types of customers: 

� Person

� Organization

Customers of type person are individuals who are not purchasing on behalf of an 
organization. A consumer can have multiple addresses and phone numbers. For 
example, a consumer can have a home address and multiple shipping addresses for 
vacation homes, friends, and relatives.

Customers of type organization may be a company, a company subsidiary or 
branch, an association, a church or a government branch.Each organization can 
have multiple addresses and multiple contacts associated with it. Each address is 
associated with the organization, not with the individual contact using that specific 
address.

Note: If an item is displayed in the Item View tab but not added to 
the quote, a message window appears prompting the user to 
continue without adding the item to the quote.

Note: You cannot create customers within Oracle Order Capture. 
To create a customer, use Oracle TeleSales 11i, Oracle Customer 
Care 11i, or Oracle Accounts Receivable 11i.
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A contact represents an organization. Any individual at an organization can be your 
contact. Business contacts within an organization are set up with roles such as Ship 
To or Bill To. An organization can have multiple contacts, addresses, and phone 
numbers.

1.5 Understanding Quotes
A quote is an offer to a customer that contains priced items and shows a total price 
for the offer. You create a quote when you accumulate items in the Quote View for a 
customer and click the Save Quote button.

Oracle Order Capture automatically assigns a number to the quote. This number 
appears in the Quote # field of the Customer Information region. The quote number 
is composed of the quote number itself and a version number that increments each 
time a new quote version is created.

For example, your administrator can specify that if a quote is in the draft stage, any 
changes you make simply overwrite your previous entries. If the quote status is bid, 
each time you save a modified quote, the application creates a new version for you. 
These restrictions and permissions can be fully determined by your organizational 
policies and implemented by your Administrator. See Understanding Quote Status 
for more details. 

Oracle Order Capture keeps a list of all of the quote versions you have created. You 
can view general information about all previous quotes for the customer by 
selecting the Quote tab in the Customer History window. You can also view the 
history of your current quote in the Quote History window. In the Order Capture 
main form, you can modify only the latest version of a quote. You cannot delete 
quotes once you create them. Your administrator can set quotes to expire 
automatically after a certain period of time. 

1.6 Understanding Quote Status
The status of a quote indicates its progress from the initial offer until the order is 
placed. As you work on a quote, you indicate its progress by changing the Status. 
Quote status tells others in your group how the negotiations with the customer are 
progressing. Depending on how your administrator has defined your Quote 
statuses, it can also determine what kind of changes you and anyone else working 
with you can make to the quote. 

The default quote statuses are automatically set when Order Capture is installed. 
You system administrator may change these statuses based on business needs.
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The status of a quote determines what kind of activities related to that quote are 
possible. Your administrator can set up and customize the rules governing each 
status in several ways, including the following:

� The administrator can decide for each status if a new version of the quote is 
created or if the quote is overwritten when you save changes to a quote.

� The administrator can decide which statuses allow modification of the quote.

� The administrator can decide the statuses to which a given status can change.

1.6.1 Pre-Defined Statuses
The following table shows the default quote statuses that are available:

Your administrator can set up additional statuses or decide not to use the included 
statuses by entering an end date for them, depending on your business processes.

1.6.2 Rules for Quote Status Changes
Status changes are regulated to prevent accidental changes, such as reverting an 
ordered quote status back to a non-ordered status.

Table 1–1 Default Oracle Order Capture Quote Statuses 

Quote Status Description

Drafted Initial status.

Bid Presented to customer.

Accepted Customer accepted terms.

Order Problem There is a problem with placing the order.

Order Reviewed The order has been reviewed.

Entered The order has been sent on to Order Management for processing 
with status Entered, i.e., it can be modified in Order Management.

Ordered The order has been sent on to Order Management for processing 
with status Booked, i.e., it cannot be changed in Order Management.

Lost The quote has not been accepted by the customer.

Inactive No more activity on this quote.
                                                Understanding Oracle Order Capture 1-11



Understanding Orders
The following table shows the suggested transition rules for quote status changes. 
The vertical columns shows the different statuses. The horizontal row shows the 
permissible status changes. 

For example, a quote with the status of accepted can only be changed to order 
problem, order reviewed, lost, inactive, or ordered/entered. A quote with the status 
of ordered cannot be modified. 
 

Please note that these rules are only suggested. Your administrator has the ability to 
add, delete and modify these status change permissions.

1.7 Understanding Orders
Order Capture allows you to place an order after a customer has decided to make a 
purchase. Order Capture estimates shipping costs and taxes before placing the 
order. 

When you place an order, Order Capture passes the order to Oracle Order 
Management, an application that determines how the order is fulfilled. You will 
receive a confirmation number which is the order number in Order Management. 

Table 1–2 Suggested Permissible Quote Status Changes

From/To Drafted Bid Accepted
Order
Problem

Order
Reviewed Ordered Lost Inactive

Drafted No Yes Yes Yes Yes Yes Yes Yes

Bid No No Yes Yes Yes Yes Yes Yes

Accepted No No No Yes Yes Yes Yes Yes

Ordered No No No No No No No No

Entered No No No No No No No No

Order Problem No No No No No Yes Yes Yes

Order Reviewed No No No No No Yes Yes Yes

Lost No No No No No No No Yes

Inactive No No No No No No No No

Note: You cannot change or remove the statuses Drafted, Entered, 
or Ordered cue to programmatic references.
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Use this number in Order Management to track final shipping costs and to verify 
that an order has been shipped. 

When an order is placed in Order Capture for items that are out of stock, Order 
Management places these items on back order and determines when and how the 
items are shipped.

For example, a customer wishes to purchase ten items. Only seven are in stock; the 
other three are expected to be available in one month. The partial order flag in 
Order Management determines whether your customer receives the partial order of 
the seven available items immediately or the whole order is shipped in one month 
when all items become available. 

Use Order Capture to update and modify quotes, not orders. To make changes to an 
order after you place it, use Order Management. 

You can access some of the Order Management forms through the Orders tab in the 
Customer History window. See Using Oracle Order Capture for more information.

1.8 Item Types
The number of item types available depends on your system administrators 
settings. See Setting up Lookup Types in the Oracle Order Capture Implementation Guide 
for more information. 

Order Capture comes with the following item types installed:

Standard items: These are generally products as opposed to services that your 
customer can purchase "as is". Standard items may include warranties that are 
shipped with the item. The Item Type field displays "Standard."

Model items: These are items that come with different options your customer can 
choose from before purchase. A configurable item displays "Model" in the Item 
Type field. When you enter a configurable item into the Item View tab, only the 
price of the most basic model appears. You can add different options to the base 
model after you add it to the shopping cart.

Serviceable items: These are items to which you can apply service items, e.g., a 
computer for which you can purchase installation. For these items, the View 
Warranty button and the Installation Details option under the Actions menu in the 
Order Capture form are enabled.

Service items: These are items such as service contracts, installations, and labor. 
Service items have a start date and an end date and are measured in units of time. 
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You must make entries in the Start Date, End Date, and Period fields when entering 
service items.

1.9 Related Items: Cross-Sell, Upsell, and Substitute
There are three kinds of related items you can access when the Related Items 
button is enabled in the Item View tab of the Order Capture form:

� A cross-sell item is an item that you can sell as an addition to the item currently 
on display. 

� An upsell item is a more expensive model that you can substitute for the 
current item. 

� A substitute item is an item you can substitute for one that is not currently 
available.

You system administrator can set up additional types of related items in Oracle 
Inventory.

1.10 How Items are Priced and Discounted
The price your customer pays for an item depends on the price lists and 
promotional discounts you enter.

1.10.1 Price Lists
The list price of an item comes from a price list. Price lists are set up in Oracle 
Pricing Manager. Your company can have many different price lists. For example, 
there may be a price list for a consumer and a corporate price list for corporate 
customers who receive an automatic discount because they buy from your company 
in bulk. You may have yet another price list for a customer that has a special 
contractual arrangement with your organization.

You can select a price list for the order as a whole and for each individual item. The 
price list for an item supersedes the price list for the whole order when determining 
the price for that specific item. 

1.10.2 Discounts
Oracle Order Capture allows both order-level and line-level discounts. Order-level 
discounts are applied to the each line on the quote, while line-level discounts are 
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applied to specific line items only. If there are multiple discounts available for an 
order or a line, the application combines them. 

Example
A customer purchases a $200 coat and a $100 shirt. There is a 10% discount 
available for the shirt and a 50% discount available for the entire order. The quote 
price is calculated as follows:

� The coat: $200 - 50% = $100

� The shirt: $100 - 60% = $40

� Total price = $140

1.10.3 Pricing Adjustments
The application is set up to calculate automatic adjustments (which are calculated in 
Advanced Pricing) applicable to the selected item and customer.

Each time you change an item on a quote, the whole quote is repriced automatically 
because a change in one item can affect the level of other offers and discounts. 

1.11 Understanding the List of Values (LOV) Fields
In Order Capture, querying on the First Name or Last Name fields for a customer 
contact retrieves a pick list of contacts that details the first name, last name, 
customer number, and telephone number. There may be duplicate customer names 
with different customer numbers.

The company name (short name) is not included in the list. Also, if you choose a 
person from this pick list, the assigned organization or customer and account 
number are not uploaded automatically. You must query the Organization and 
Account fields to retrieve the values for the person specified.

The logic in the First Name and Last Name LOVs in Order Capture is closely 
integrated with the values in the Organization and Account fields. This integration 
controls the behavior of the Contacts LOVs in the following ways:

� If you specify an organization and query on the First Name and Last Name 
fields, the LOVs display all the persons associated with the organization by a 
relationship type of "Employee of" or "Contact of."
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� If you query on the First Name and Last Name fields without specifying an 
organization, the LOVs display all the persons from Trading Community 
Architecture (TCA).

� If you specify the First and Last Name values first, then query on the 
Organization field, the LOV displays all the organizations for which this 
person is a contact or employee.

� Customer Number is not the same as Account Number. If you specify a 
customer, either a consumer or a business, then query on the Account field, the 
LOV displays only the accounts for that customer. If you do not specify a 
customer, then the LOV retrieves all accounts.

� If you specify First Name and Last Name, but not Organization, the party 
for the quote is a consumer (B2C case). If you then query the Accounts field, 
the LOV displays all the valid accounts for this person.

� If you specify Organization, the party for the quote is a business (B2B case). 
If you then query on the Account field, the LOV displays all the valid 
accounts for this organization.

1.12 Understanding the Item and Price List LOVs
The Item and Price List LOVs are also closely integrated with each other and with 
the Unit of Measurement (UOM) and Currency fields. An item must always be 
specified with a UOM, and the price lists available for you to select are always 
limited by the currency chosen.

If you select a price list without selecting an item first, the Item LOV shows only 
items in that price list. Selecting a price list in the Item View tab limits the Item LOV 
for that line only, not the entire quote. Selecting a header level price list in the 
Payment tab limits the Item LOVs for all items in the quote that do not have a line 
level price list in the Item View tab.

Note: You should choose the currency before choosing any items 
or price lists. If you change the currency after choosing items or 
price lists, the Item and Price List fields do not refresh or go blank 
automatically. You must then reselect each item and price list to 
obtain values that are legitimate for the chosen currency. Otherwise, 
Oracle Order Capture will return an error message when you try to 
save the quote or place the order.
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If you select an item and its UOM without selecting a price list first, the Price List 
LOV in the Item tab shows only price lists where the item and its specified UOM 
exist, as determined by the pricing API. For example, if you select a gallon of 
"Clover Honey," then the Item Price List LOV shows only the price lists for the 
chosen currency that include "Clover Honey" with the UOM "gallon." The Item 
Price List LOV does not show price lists that include "Clover Honey" with the UOM 
"pint."

If you select a UOM and a price list, without selecting an item first, the Item LOV 
shows only items with the selected price list and UOM.

The UOM LOV is not restricted by price lists, but it is restricted by item. If you 
select an item, its UOM and a price list, and that UOM is not on the specified price 
list, Pricing will check for the primary UOM for that item and return a price for the 
primary UOM. For example, you select a gallon of "Clover Honey" and a price list, 
yet the UOM gallon is not on the price list. Pricing will search for the primary UOM 
for "Clover Honey", which happens to be pint. Pricing will return a price for pint, 
even though gallon is still the selected UOM. If you select an item, the UOM LOV 
returns all valid UOMs for the item.

 The following table demonstrates how the interrelationship between the Item, 
UOM, and Price List LOVs affects their values.

Table 1–3 Item, UOM, and Price List LOV Behavior

Is a Price List 
Selected?

Is an Item 
Selected?

Is a UOM 
Selected? Behavior

Yes No No LOVs display all items and UOMs on 
the specified price list.

No Yes No Price List LOV displays all price lists 
for the specified item.

Yes - header 
level

No No Item LOV displays all items on the 
specified price list, that do not have 
line level price lists.

No Yes Yes LOV displays only price lists where 
the specified item and UOM exist.

Yes No Yes Item LOV shows only items with 
selected UOM and price list.

Yes Yes Yes - but this 
UOM is not on 
selected price 
list

Pricing searches for the primary 
UOM for the item and returns a price 
based on the primary UOM.
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1.12.1 Agreements
If an agreement has been selected in the Payment tab, Order Capture will default 
the price list based on the agreement. Yet, the user can override the default price list 
by choosing one from the price list LOV.

1.12.2 Related Items and Warranties
You may need to select a different price list when choosing a related item or a 
service for an item currently in the Item View tab.

When you select a related item or service Order Capture will display an LOV form 
with a list of valid price lists for the user to choose from. If only one price list exists, 
the system will automatically choose that price list and price the item accordingly.

See Cross-Selling, Upselling, and Substituting Items for information on how to 
choose a related item for an item currently in the Item View tab.

See Adding a Service to the Shopping Cart for information on how to choose a 
service for an item currently in the Item View tab.

Note: Order Capture only displays current items that will expire 
from the chosen price list on or after the designated quote 
expiration date. 
1-18 Oracle Order Capture Concepts and Procedures                      



                                                          Using Oracle Order Ca
2

Using Oracle Order Capture

2.1 Overview of Using Oracle Order Capture
This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

� Creating a Quote

� Selecting an Existing Customer in the Order Capture Form

� Selecting an Item in the Item View Tab

� Clearing an Item from the Item View Tab

� Adding Items to the Shopping Cart for a Quote or Order

� Removing Items from the Shopping Cart or Quote

� Entering Payment Information

� Entering the Billing Address for an Order

� Entering the Shipping Address for an Order

� Shipping an Item to Alternate Destinations

� Searching Using the Query Method

� Viewing the List of Items in the Shopping Cart or Quote

� Scrolling Through the Items in the Shopping Cart

� Determining If an Item Has Been Added to the Shopping Cart

� Adding a Service to the Shopping Cart

� Viewing Warranty Information for an Item

� Entering Installation Details
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� Configuring an Item

� Cross-Selling, Upselling, and Substituting Items

� Finding Out When an Item Will Be Available

� Pricing an Item

� Pricing Configurable Items

� Adjusting Prices of an Item in a Quote

� Adjusting Prices for a Whole Quote

� Viewing Adjustments

� Copying a Quote

� Printing a Quote

� Viewing the Status of a Print Job

� Viewing the History of a Quote

� Viewing Customer Quotes

� Modifying a Customer Quote

� Placing an Order

� Viewing Customer Orders

� Using Descriptive Flexfields

2.2 Creating a Quote
A quote lists the items your customer is interested in purchasing before you place 
an order. Use this procedure to create a quote.

Steps
1. Log in to Oracle Forms under the Order Capture Sales Agent responsibility.

2. Choose Order Capture from the Navigator.

3. Enter the customer information for the quote.

a. Use the First Name LOV to enter the customer or contact’s first name.

b. Use the Last Name LOV to enter the customer or contact’s last name.

c. Use the Phone LOV to enter the customer’s phone number
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d. Use the Organization LOV to enter the customer’s organization.

e. Use the Account LOV to enter an account number for the customer. If there 
is only one account number, this field will automatically populate when 
you select a customer.

f. Enter a name for the quote in the Quote Name field.

g. Use the Sales Rep LOV to enter a sales representative for the quote.

4. Add items to the quote.

a. Use the Item LOV in the Item View tab to select an item.

b. Use the UOM LOV to enter a unit of measurement for the item. The default 
UOM for the item will automatically populate the field.

c. Enter the quantity you wish to purchase in the Qty field. The default 
quantity will automatically populate the field.

d. Use the Price List LOV to choose a price list for the item. 

e. If the item has related items available, the Related Items button will be 
enabled. Use this button to cross-sell, up-sell, or substitute an item.

f. Click the Add to Cart button.

Once you click this button, the item shows up in the Shopping Cart tab.

5. Adjust discounts by changing price list selections. This is an optional step. For 
instructions, see Adjusting Prices of an Item in a Quote and Adjusting Prices for 
a Whole Quote.

6. Click Save. 

The application saves the quote under the number listed in the Quote # field in 
the Header Information Region.

2.3 Selecting an Existing Customer in the Order Capture Form
Use this procedure to find and enter a customer in the Header information Region 
of the Order Capture form. 

Prerequisites
The customer must exist in the database.
                                                           Using Oracle Order Capture 2-3



Selecting an Existing Customer in the Order Capture Form
Steps
1. Navigate to the Order Capture form.

2. If a customer is already displayed in the Header Information region, then: 

a. Place your cursor in either the last or first name fields.

b. Click New in the File menu. 

c. A dialog box appears asking if you wish to save your changes. 

d. Save or cancel any changes you have made by clicking the appropriate 
button.

The Header Information Region clears.

3. If you know the account number for your customer, then:

a. Enter the account using the Account LOV.

If the customer is a person, the customer’s name appears automatically. The 
Organization field remains blank.

If the customer is a business contact, the Organization name appears 
automatically.

b. If the customer is a business contact and the organization appears 
automatically without a contact name, select the correct contact using the 
Last Name LOV.

4. If the customer is a consumer and you do not know that customer’s account 
number, then:

a. Use the Last Name LOV to enter the customer’s name.

b. If the name is a common name and the list of names in the LOV is too long, 
use the query method to search on the name and partial phone number. 

5. If the customer is a business customer and you do not know the account 
number, then:

a. Use the Organization LOV to enter the customer’s organization.

Selecting an organization restricts the names displayed in the first name 
and last name LOVs to contacts at that organization.

b. Use the Last Name LOV to enter the customer’s last name.
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2.4 Selecting an Item in the Item View Tab
Use this procedure to enter an item into the Item View tab.

Prerequisites
None.

Steps 
1. Navigate to the Item View tab.

2. Place your cursor in the Item field.

3. If the Item View tab already displays an item, then click New Record in the 
toolbar. This is the button with a green plus sign.

4. Use the LOV to enter the item.

The item displays in the tab. You are now ready to add the item to the cart.

2.5 Clearing an Item from the Item View Tab
Use this procedure to remove from the Item View tab an item that has not yet been 
added to the shopping cart.

Prerequisites
The item must be displayed in the Item View tab.

Steps
1. Navigate to the Item View tab.

2. Check to see if the item displayed has been added to the shopping cart.

3. If it has not been added to the shopping cart, then click Clear.

Note: See Understanding the List of Values (LOV) Fields for a 
detailed explanation of the LOV behaviors on the form.
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2.6 Adding Items to the Shopping Cart for a Quote or Order
Use this procedure to add items to the shopping cart. The procedure is the same 
whether you are creating a quote or an order.

Prerequisites
Your customer must be displayed in the Header Information Region of the Order 
Capture form.

Steps 
1. Navigate to the Item View tab.

2. Place your cursor in the Item field.

3. If the Item View tab already displays an item, click New Record in the toolbar. 
This is the button with a green plus sign.

4. If the Item View tab is blank, use the LOV to enter the item.

The item displays in the tab. 

5. Enter the quantity in the Qty field. 

6. If the Item Type is Model, then the item is configurable. The item displayed is 
the base model. You can configure this item to add more components.

For all other items the item pricing appears. The Unit Price shows the list price 
of this item from the price list shown in the Price List field.

7. If the Related Items button is enabled, you can view and select upsell, cross-sell, 
and substitute items.

8. If you wish to add this item into the shopping cart, click Add To Cart.

9. Repeat this procedure to add other items to the shopping cart.

When you are done you are ready to:

� Create a quote

� Place an order

2.7 Removing Items from the Shopping Cart or Quote
Use this procedure to remove items from the shopping cart or quote.
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Prerequisites
There must be at least one item in the shopping cart.

Steps
1. Navigate to the Item View tab.

2. Check to make sure you are viewing the contents of the shopping cart.

If the Item View tab displays an item not in the shopping cart, then clear it by 
clicking Clear.

3. If the shopping cart contains multiple items, use the arrow buttons to display 
the item you wish to delete. 

4. With the item to be deleted displayed in the Item View tab, click Remove.

2.8 Entering Payment Information
Use this procedure to enter payment information for your customer. 

Prerequisites
The Header Information Region must display the customer.

Steps
1. Choose the Payment tab.

2. Use the Agreement LOV to enter an agreement, if one exists.

Agreement terms with a customer are set up by your company in Oracle 
Pricing. Agreements can include price lists, discounts, payment terms, and 
shipping address.

3. Select the payment terms using the Payment Terms LOV. 

4. From the Payment Type drop-down list, select the payment type.

a. If you have selected cash as the payment type, click Save on the toolbar.

b. If you have selected check as the payment type, then:

– In the Number field, enter the check number.

c. If you have selected purchase order as the payment type, then:

– In the Number field, enter the purchase order number.
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d. If you have selected credit card as the payment type, then:

– From the Credit Card drop-down list, select the credit card type.

– Enter the credit card holder’s name.

– In the Number field, enter the credit card number.

– Enter the expiration date.

e. Click Save on the toolbar. 

If Oracle iPayment is also installed, the application performs a credit card check 
and displays an approval code. For more information, consult the iPayment 
Concepts and Procedures manual. 

2.9 Entering the Billing Address for an Order
Use this procedure to enter a billing address for an order.

Prerequisites
� The Header Information Region of the Order Capture form must display the 

customer.

� The individual to be billed and the billing address must already exist in the 
database.

Steps
1. Select the Bill To tab.

2. If no name appears in the Name field or you wish to bill a different individual, 
then use the Name LOV to enter the correct name.

3. Use the Address LOV to select a billing address.

4. If the shipping address is the same as the billing address, place a check in the 
box next to "Ship to the Same Address".

5. Click Save on the toolbar.

2.10 Entering the Shipping Address for an Order
Use this procedure to enter the shipping address for the order.
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Prerequisites
The Header Information Region of the Order Capture form must display the 
customer.

Steps
1. Select the Ship To tab.

2. If the correct individual does not appear in the Name field, then enter the 
individual using the LOV. 

3. If you wish to ship individual items to a different shipping address than the one 
you enter here, follow the procedure outlined in Shipping an Item to Alternate 
Destinations.

4. Use the Address LOV to select a shipping address.

5. Click Save in the Toolbar.

2.11 Shipping an Item to Alternate Destinations
Use this procedure to ship an item to one or more addresses that are different from 
the shipping address for the order as a whole.

You can use this procedure to ship quantities of an item to multiple locations. For 
example, a customer who is ordering an item with a quantity of 10 can ship two to 
one address, three to another, and five to a third.

Prerequisites
You must save your quote before performing this procedure.

Steps
1. Display the item you wish to ship to an alternate destination in the Item View 

tab.

2. Place the cursor in an Item View field.

3. From the Actions menu, choose Shipping.

The Shipping form appears.

4. In the Qty field, enter the quantity you wish to send to the alternate address.

You can specify a partial quantity or the whole quantity, depending on whether 
you wish to send an item to one or more shipping addresses.
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5. Use the Ship To LOV to enter the name of the individual to which you wish to 
ship the item.

6. Use the Address LOV to enter an address.

7. Enter any shipping or packing instructions.

8. If you wish to ship another quantity of the same item to a different destination, 
click Next and repeat the above steps.

9. Click Apply to Shipment to apply the alternate shipment address.

10. Click OK to save the new shipping addresses and return to the main Order 
Capture form.

2.12 Searching Using the Query Method
Use this method to search for customers or addresses in Order Capture using 
multiple criteria. 

Prerequisites
None.

Steps
1. Place your cursor in one of the fields in the region you wish to search.

2. From the View menu, choose Query by Example > Enter.

The searchable fields turn blue.

3. Enter a full or partial value into one of the fields. You can use a wild card. For 
example, if you enter F%, the application returns all entries starting with the 
letter F.

4. From the View menu, choose Query by Example > Run.

5. The application displays a matching entry, if any.

6. Check the status bar to see how many matching entries were found. If the 
application found more than one matching entry, then click the cursor in any 
field and use the down arrow on the keyboard to scroll through.

Note: This general method of searching can also be used 
in other Forms application forms.
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2.13  Viewing the List of Items in the Shopping Cart or Quote
Use this procedure to view a list of items in the shopping cart.

Prerequisites
An item must be added to the shopping cart before it appears in the list.

Steps
1. Click on the Shopping Cart View tab.

The list of items in the list displays. 

2. If you wish to view the details of an item in the list, then: 

a. Note the item’s position in the list.

b. Select the Item View tab and scroll to the item.

2.14 Scrolling Through the Items in the Shopping Cart
Use this procedure to scroll through the items in the shopping cart. 

Prerequisites
You must have items added to your quote.

Steps
1. Navigate to the Item View tab of the Order Capture form.

2. If the tab displays an item, check to see if it is in the shopping cart.

3. If the tab displays an item that has not been added to the shopping cart, then, 
before you can view the shopping cart, you must either:

� Clear it by clicking Clear.

� Add it to the shopping cart by clicking Add to Cart.

Click the appropriate button to scroll through the shopping cart:

� Use the right arrow button to advance to the next item in the quote. If you are 
viewing the last item in the quote, clicking this button creates a new item in the 
quote.

� Use the left arrow button to go to the previous item in the quote.
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� Use the double right arrow button to go to the last item in the quote.

� Use the double left arrow button to go to the first item in the quote.

2.15 Determining If an Item Has Been Added to the Shopping Cart
Use this procedure to determine if the item displayed in the Item View tab has been 
added to the shopping cart.

Prerequisites
The Item View tab displays an item.

Steps
1. Navigate to the Item View tab of the shopping cart.

2. Check if the Current Item field and the Items in Shopping Cart field both 
display numbers. 

� A number in both fields indicates you are viewing an item already in the 
shopping cart.

� A number in only the Items in Shopping Cart field indicates the item 
displayed has not yet been added to the cart.

� If both fields are empty, there are no items in your quote.

2.16 Adding a Service to the Shopping Cart
Use this procedure to enter a service for a serviceable item in a quote or order.

You can apply a service only against a serviceable item already in the database. The 
item can be in a quote, order, or the customer’s installed base of products. You 
cannot purchase a service on its own. 

Prerequisites
Your customer must be displayed in the Header Information Region of the Order 
Capture form.

Steps 
1. Navigate to the Item View tab.

2. Place your cursor in the Item field.
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3. If the Item View tab already displays an item, then click New in the toolbar. 

4. If the Item View tab is blank, then use the LOV to enter the item.

The item displays in the tab. 

5. Enter either the start date and the end date for the service or the start date and 
the duration. 

6. Click Add to Cart.

The Service Reference form appears.

7. Select the appropriate category from the Service For list:

� Quote: if the service is for an item in a quote.

� Order: if the service is for an item in an order.

� Customer Product: if the service is for an item in a product already 
installed at a customer site.

8. If the service is for a quote item, use the Reference Number LOV to enter the 
line number of the item. The reference number is a concatenation of the quote 
number and the line number of the item.

9. If the service is for an order item, use the Reference Number LOV to enter the 
line number of the item. The reference number is a concatenation of the order 
number and the line number of the item.

10. If the service is for an item that is already installed at a client site, enter the 
serial number of the item.

11. Click OK to save and close the Service Reference form, and return to the Order 
Capture form.

The Service item is added to the cart at this point.

12. Repeat this procedure to add other items to the shopping cart.

13. When you are done you are ready to:

� Create a quote

� Place an order
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2.17 Viewing Warranty Information for an Item
Use this procedure to view the warranty information for an item displayed in the 
Item View tab. The View Warranty button is only enabled if the item includes a 
warranty.

Prerequisites
The item must be added to the quote and displayed in the Item View tab.

Steps
1. Click View Warranty.

The Warranties window appears displaying a list of warranties included with 
the item. This window is read-only.

2.18 Entering Installation Details
Use this procedure to enter installation details for serviceable items. Serviceable 
items are items for which your customer can purchase service agreements.

Prerequisites
The item must be added to the shopping cart and displayed in the Item View tab. 

Steps
1. The cursor must be in one of the fields in the Item View tab.

2. From the Action menu, choose Installation Details.

The Installation Details form appears. This is an Oracle Service form.

3. In the Transaction tab, use the Transaction Type LOV to select a transaction 
type. 

4. Enter a quantity.

This field is dependant upon the designated type. If the Type requires a 
quantity, it is enabled. Otherwise, it is a read-only field.

5. If the item requires a new system to be created, then:

a. Click AutoCreate System.

The AutoCreate Systems form appears.
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b. Enter the quantity.

c. Enter the other values using the LOVs.

d. Click OK.

6. Use the System LOV to enter a system.

7. Use the Contact LOVs to enter optional contacts for the installation.

8. Use the Location LOV to enter a location where the item is to be installed.

9. If you have not selected New as the transaction type, then enter a reference 
number in the Reference tab.

10. Click Add.

11. Click OK.

2.19 Configuring an Item
Use this procedure to configure a Model item.

Prerequisites
� The Model item must be displayed in the Item View tab and must be added to 

the quote. 

� The quote must be saved.

Steps
1. Display the item you wish to configure in the Item View tab.

2. The cursor must be in an Item View field.

3. From the Tools menu, choose Configure Item.

The Oracle Configurator form appears.

4. In the left pane of the window, select the category of option you wish to add to 
the base item.

The items in the category and their descriptions appear in the top right hand 
pane.

5. Select the item(s) you wish to add to the shopping cart by clicking the check 
boxes to the left of each item. 
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6. After adding each component, click on the arrow button to the right of the Total 
Price field to view the total price of the configured item.

7. Click Done.

The items you selected are added to the shopping cart. 

2.20 Cross-Selling, Upselling, and Substituting Items
Use this procedure to sell a substitute, a cross-sell, or up-sell item to your customer. 

Prerequisites
� The item you wish to cross-sell, upsell, or replace with a substitute must be 

added to the shopping cart and displayed in the Item View tab. 

� The Related Items button must be enabled, indicating that related items have 
been set up for this product. (This button will not be enabled if relationships are 
not set up correctly in Oracle Inventory).

Steps
1. Click Related Items in the Item View tab.

The Related Items window appears.

2. To add a related item to the cart:

a. Click on one item in the list to select it.

b. Click OK.

A pop-up window shows the available price lists for the related item. If 
only one price list exists, Order Capture will automatically choose that price 
list and price the item accordingly.

c. Choose a price list for the related item.

d. Click OK to close the price list window and return to the Order Capture 
form.

3. The item you selected in the Related Items window and its price is displayed in 
the Item View tab. 

4. Click Add to Cart for any item you wish to add to the cart.

Guidelines
Here is how choosing a related item changes the shopping cart:
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� Adding an upsell item replaces the item in the cart.

� Adding a cross-sell item adds the item to the cart. You can add multiple 
cross-sell items to the cart.

� Adding a substitute item replaces the item in the cart.

See Understanding Oracle Order Capture for more details about related items.

2.21 Finding Out When an Item Will Be Available
Use this procedure to find out when the desired quantity of an item will be 
available. You need to use this procedure only when the quantity available in the 
Qty field is less then the quantity desired by your customer. 

Items are reserved for your customer either when you place the order or not at all. 
The point at which inventory items are reserved for your customer depends on the 
setting of the system profile option ASO: Reservation Level. Contact the application 
administrator for details. Items are not reserved for your customer before you 
successfully place the order. 

Prerequisites
The item must be displayed in the Item View tab of the shopping cart.

Steps
1. From the Actions menu, choose Availability - Item.

The Available Date field displays the date when all of the requested quantity 
will be available for shipping.

If you place the order, then your customer receives all of the currently available 
quantity. The balance is placed on back order and shipped on the available date.

2. Click OK.

The available date becomes the date in the Scheduled field of the Item View tab.

2.22 Pricing an Item
Use this procedure to price an item in the Item View tab. The price list of an item 
can be designated either at the header level or the item level. Price lists at the 
header level apply to all items in a quote, while price lists at the line level apply 
only to the item displayed in the Item View. Item level price lists supersede header 
level price lists. For more information, see How Items are Priced and Discounted.
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Prerequisites
You must know to which price list or lists the item belongs.

Steps
1. If you wish to apply one price list to all items in your quote, choose a price list 

from the Payment tab before adding items to the quote.

2. If you wish to apply a price list only to the item displayed in the Item View tab:

a. Enter the item into the Item View tab.

b. Enter the quantity in the Qty field.

c. If the Item Type is model, then you must view its price following the 
procedure outlined in Pricing Configurable Items.

d. If the item is a service, then use the Period and Duration LOVs to enter the 
period and duration of the service.

e. A default price list will automatically populate the Price List field in the 
Item View tab. Use the LOV to enter a different price list.

The item pricing appears. The Unit Price shows the list price of this item from the 
price list displayed in the Price List field.

You are now ready to:

� View an item or add another item to the quote

� Create a quote

� Adjust prices

� Enter payment information

2.23 Pricing Configurable Items
Use this procedure to price configurable items. You must configure these items 
before pricing because their price depends on the options your customer chooses.

Prerequisites
The Item View tab must display an item of Item Type Model. 

Steps
1. Click Add to Cart to add the model item into the shopping cart.
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2. The Item View tab displays the model item. This is usually the most basic 
configuration.

3. Configure the item. See Configuring an Item for instructions.

List prices for each component are visible in the Configurator window.

4. Navigate back to the model you entered originally to view the total price of the 
item and its options. 

5. If your customer decides not to purchase the item after you have configured it, 
then you must remove the item. (The components are removed automatically.) 
See Removing Items from the Shopping Cart or Quote for instructions.

6. To reconfigure the item, use the Configure Items option in the Action Menu.

2.24 Adjusting Prices of an Item in a Quote
Use this procedure to adjust the price of an item for your customer.

Prerequisites
The item and its price must be displayed in the Item View Tab.

Steps
You can modify prices for an individual item in your quote by:

� Selecting a different price list from the Price List LOV. Different price lists can 
price the item differently. 

� You can also modify the price of an item by selecting the item and then selecting 
the Promotions option in the Action menu. You will see any available 
promotions that apply to the item. When you select the promotion, the item 
price will be adjusted.

2.25 Adjusting Prices for a Whole Quote
Use this procedure to adjust prices for an entire quote, for example, if there was a 
promotion that gave customers 20% off their entire order.

Prerequisites
The quote you wish to adjust must be displayed in the Order Capture form.
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Steps
You can adjust the prices for your quote by:

� If you have not selected any items for your quote, you can modify prices for a 
whole quote by selecting a different price list for the quote in the Payment tab. 
See Pricing an Item for more information. Any items that are added will use the 
new price list selected. 

� If you already have items in your quote, you must select the new price list for 
each item. See Adjusting Prices of an Item in a Quote.

� You can also modify the price of a whole quote by selecting the Promotions 
option in the Action menu. You will see all available promotions that are set up 
in Pricing, even those that are not applicable to your quote. When you select the 
promotion, the quote price will be adjusted.

To adjust prices for an individual item rather than for the quote as a whole, see 
Adjusting Prices of an Item in a Quote.

2.26 Viewing Adjustments
Use this procedure to view price adjustments. Price adjustment details are read-only 
in Order Capture. All price adjustments are set up in Oracle Pricing.

Prerequisites
The items in the quote must be saved as a quote.

Steps
To view discounts for the order as a whole:

1. Place the cursor in any field in the Header Information Region.

2. From the Actions menu, choose Price Adjustments.

The Price Adjustments window appears.

The window lists the adjustments that apply to all lines on the order, yet it does 
not show line level adjustments. You cannot make any modifications.

3. Click OK to return to the main Order Capture form.

To view adjustments for an individual item:

1. Place the cursor in any field for the item.

2. From the Actions menu, choose Price Adjustments.
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The Price Adjustments window appears.

The window lists the adjustments that apply for this line. You cannot make any 
modifications.

3. Click OK to return to the main Order Capture form.

2.27 Copying a Quote
Use this procedure to copy a quote. You can copy either just the basic contact and 
quote information, billing and shipping addresses, and payment information, or the 
entire quote including the line item and pricing information. For example, a user 
could use Copy Quote: Header Only if they need to create another quote for the 
customer who’s quote is currently displayed in the Order Capture form. Copy 
Quote: Header and Lines could be useful for a user who wants to create two copies 
of the same quote with an item difference. 

Prerequisites
The original quote must be displayed in the Order Capture form.

Steps
1. Place the cursor in a header level field.

1. From the Tools menu, select Copy Quote.

The Copy Quote window appears.

2. In the Copy Quote window under the Copy heading, highlight the radio button 
for one of these two options:

� Header only: This option copies the basic contact and quote information in 
the Order Capture form header, and the address and payment information 
in the Bill To Address, Ship To Address, and Payment tabs.

� Header and lines: This option copies all of the information copied by the 
Header only option, along with the quote’s line item details.

3. Under the Copy To heading, highlight the radio button for one of these two 
options:

� New quote: This option copies the quote information you selected under 
the Copy heading into a new quote.
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� Revision: This option copies the quote information you selected under the 
Copy heading into a new version of the existing quote. You cannot create a 
revision of a quote with Entered or Ordered status.

4. Click OK. A new or revised quote is created and appears in the Order Capture 
form. The quote number is automatically generated.

2.28 Printing a Quote
Use this procedure to print a quote. The ability to print a quote allows users to give 
customers hard copies of quotes that have been entered in the Order Capture UI.

The Print Quote report displays all the information available to users in the Order 
Capture UI, including header level, line level, and pricing information. Oracle 
Order Capture uses Oracle Reports to produce the Print Quote report.

Prerequisites
The report functionality must be set up in Oracle Reports. The quote must be Saved 
and must be displayed in the Order Capture form.

Steps
1. From the Tools menu, select Print Quote.

A Note window opens with a Request ID #. Record this number if you want to 
view the status of your print job.

2. Click OK.

2.29 Viewing the Status of a Print Job
Use this procedure to view the status of a print job. This procedure is useful if you 
are having problems printing your document or if you want to check which printer 
you have set up.

1. Navigate to View > Requests.

2. Choose Specific Requests.

3. Enter the Request ID #, generated when you choose Print Quote from the Tools 
menu, into the Request ID field.

4. Click Find.

A Requests pop up window opens, displaying your request and its status.
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5. To view what the print out will look like, click on the View Output button.

6. Close the window.

2.30 Viewing the History of a Quote
Use this procedure to view the history of the current quote. The quote history gives 
you basic information only. This includes the dates and times when previous 
versions of the quote were created as well as the identity of the individual who 
created them. You cannot view the detailed pricing of the quote in this version of 
Order Capture.

Prerequisites
The quote must be displayed in the Order Capture form.

Steps
1. From the Reports menu, select Quote History.

The Quote History window appears listing basic information about this quote.

2. Click OK to close this window.

2.31 Viewing Customer Quotes
Use this procedure to view a list of the quotes prepared for this customer. 

Prerequisites
The customer must be displayed in the Order Capture form.

Steps
1. From the Reports menu, select Customer History.

The Customer History window appears.

2. Select the Quotes tab.

The tab lists all quotes for this customer. 

2.32 Modifying a Customer Quote
Use this procedure to find and modify a customer quote.
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Prerequisites
The customer must be displayed in the Order Capture form.

Whether you can modify a quote depends on its status. Not all quote statuses allow 
you to make modifications. Modification permissions are set up by the application 
administrator. For example, your administrator can specify that a quote with a 
status of ordered cannot be modified.

Steps
1. From the Reports menu, select Customer History.

The Customer History window appears.

2. Select the Quotes tab.

The tab lists all quotes for this customer. 

3. If you wish to view the quote and modify it, click View Quote.

The quote displays in the Order Capture form. Only the latest version of a quote 
can be modified.

4. Modify the quote by:

� Modifying customer information

� Changing item quantities

� Adding Items to the Shopping Cart for a Quote or Order

� Adjusting Prices of an Item in a Quote

� Removing Items from the Shopping Cart or Quote

� Entering the Billing Address for an Order

� Entering the Shipping Address for an Order

5. If required by your departmental procedures, change the status of the quote by 
selecting an appropriate status from the Status LOV. For example, when a 
customer approves a quote, you can change the status of a quote from draft to 
approved. 

6. Click the Save button.

Depending on the status of the quote, the changes you have made are saved 
either in the version of the quote you are editing or in a new version. See 
Understanding Quote Status for more information.
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2.33 Placing an Order
Use this procedure to create an order directly from the Order Capture form or from 
a quote you have created. 

Steps
1. If you are creating an order from a quote, display the quote in the Order 

Capture form.

2. Add items to the quote, if necessary. See Adding Items to the Shopping Cart for 
a Quote or Order for more information.

3. Adjust discounts. This is an optional step. See Adjusting Prices of an Item in a 
Quote and Adjusting Prices for a Whole Quote.

4. If the billing information in the Bill To tab has not been entered, then enter it.

5. If the shipping information in the Ship To tab has not been entered, then enter 
it.

6. If the payment information in the Payment tab has not been entered, then enter 
it.

7. Click Place Order.

Your order is submitted to Oracle Order Management and you receive a 
confirmation number. You must track the order in Order Management to check 
on its status and to make sure that the order is filled and shipped.

2.34 Viewing Customer Orders
Use this procedure to view orders placed by this customer with Order Management. 
This includes, but is not limited to, the orders placed through Order Capture. 

Prerequisites
The customer must be displayed in the Order Capture form.

Steps
1. From the Reports menu, select Customer History.

The Customer History window appears. 

2. Select the Orders tab.

3. Select an order and click View Order to view its details.
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The order information displays in an Order Management window. For 
instructions on how to use Order Management, consult the help system for that 
application.

4. If you wish to create a new order, click New.

2.35 Using Descriptive Flexfields
Use this procedure to enter information into flexfields. 

See the Oracle Order Capture Implementation Guide and the Oracle Applications 
Flexfields Guide for more information on setting up flexfields.

Prerequisites
Flexfields must be set up/customized identically in Order Capture and Order 
Management.

Steps
1. Click in the descriptive flexfield to display the flexfield form.

2. Enter a value into each segment, either by typing it in or by choosing from the 
LOV.

3. Click OK to close the flexfield form.
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